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Read Me First 
 
Welcome to Take Control of Fonts in Snow Leopard, version 1.0, 
published in August 2010 by TidBITS Publishing Inc. This book was 
written by Sharon Zardetto and edited by Tonya Engst with help 
from Caroline Rose and Jeff Carlson. 

This book tells you everything you need to know (and then some!) 
about fonts on your Mac: what and where they are, how to organize 
them, how to access the hidden wealth of characters inside some 
of them, and how to use the Mac OS X font tools—Font Book, 
Keyboard Viewer, and Character Viewer/Palette. It demystifies 
Unicode, explains how to organize your font collection, and more. 

Copyright © 2010, Sharon Zardetto. All rights reserved. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to buy 
a new copy to read it more carefully or to keep it for reference. 
Discounted classroom and Mac user group copies are also available. 

UPDATES AND MORE 
You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to pur-
chasers). On the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount.  

• Download various formats, including PDF and—usually—EPUB and 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top 
of the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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BASICS 
When reading this book, you may get stuck if you don’t know certain 
basic procedures or don’t understand Take Control syntax for things 
such as working with menus or finding items in the Finder. Please note 
the following: 

• Menus: To describe choosing a command from a menu in the 
menu bar, such as choosing Resolve Duplicates from the Edit menu 
in Font Book, this book uses the format “Edit > Resolve Duplicates.” 
When the actual command name changes based on a special situa-
tion or selection, there’s a generic reference: if the command would 
be File > Remove “NewFlier” based on the name of the selection, 
the description is File > Remove CollectionName. 

• Contextual menus: When I refer to accessing a contextual menu, 
I usually write “Control-click on [whatever] for the contextual 
menu…”. This is a somewhat amusing since I never Control-click: 
my main computer is a laptop, and I use a two-finger tap for a 
contextual menu. You might do the same, or you may be using a 
mouse that’s programmed to open a contextual menu with a right-
click. Whenever you read “Control-click,” use whatever method you 
like to open a contextual menu. 

• System Preferences: Working with certain aspects of fonts means 
taking some trips to System Preferences. To get there, choose System 
Preferences from the Apple  menu. Each icon in the Preferences 
window opens a pane of information. So, if I say “In the Keyboard 
pane of System Preferences” or “in the Keyboard preference pane,” 
you’ll know you have to choose  > System Preferences and click on 
the Keyboard icon. Some panes have multiple screens, accessed by 
clicking the blue buttons in the pane, so the directions might say 
“…in the Keyboard Shortcuts screen of the Keyboard pane…”. 

• References to Fonts folders: The three basic Fonts folders 
you have to deal with are informally known as User Fonts, System 
Fonts, and Library Fonts; their paths are very similar and easy to 
confuse, so check Decode Fonts Folder Paths (p. 22) to see how to 
easily differentiate them. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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• Paths: The route you take to a file on a drive, whether by looking 
through columns in a window or by double-clicking your way 
through folders, is the file’s path. The syntax for paths conforms to 
Unix standards, because that’s what underlies Mac OS X. The disk’s 
name is always the first thing in a path; since we can assume that 
the disk is always there, we don’t include its name in the path, but 
we preserve the slash that would separate it from the next item. So, 
HardDrive/System/Library/Fonts becomes /System/Library/Fonts. 

A path to something in a user’s home directory starts with the 
drive’s name, followed by Users and then the user’s name. The 
handy convention, however, is to replace those first three items 
with ~ (tilde), so HardDrive/Users/Jerry/Library/Fonts becomes 
simply ~/Library/Fonts. 

How to Follow a Path in This Book with Copy and Paste 
For any complete path to a folder (that is, there are no double 
periods in it for a missing component, and it ends in a folder 
name, not a filename), you can—assuming you’re working with 
this ebook on your Mac—get to the folder quickly: Copy the path 
from the PDF; in the Finder, choose Go > Go to Folder; paste the 
path into the dialog; and click the Go button. 

ASSUMPTIONS 
Yes, I know what they say about “assume” but I’m going to anyway. 
As long as you know what the assumptions are, we can prevent some 
misunderstandings: 

• You’re working in Mac OS X 10. 5 Leopard or 10.6 Snow 
Leopard: Until the relatively small change from Leopard to Snow 
Leopard, font management in Mac OS X changed drastically from 
one major release to the next. Almost nothing in this book applies 
to versions before 10.4 Tiger, and much of it doesn’t apply to Tiger, 
either. It’s not just fonts or font handling that changes—peripheral 
things such as searching for fonts or even working in a Get Info 
window often change from one system version to the next. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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• You have administrative access to your Mac: I do mention, 
in a few places, the difference having access (or not) might mean, 
but the general assumption is that you’re in charge. (If you’re 
uncomfortable with, or confused by, the very idea of “administrative 
access,” Appendix B: Users and Accounts can ease your mind.) 

• You’re not using third-party font management software: 
Wherever I discuss Font Book and its use, I assume that Font Book 
is your font management software. You can’t have more than one 
of these utilities running at a time, so if you’re working with a third-
party solution but want to try (or go back to) Font Book, you should 
first disable the third-party manager. 

• You have Microsoft Office and/or Adobe Creative Suite: 
(Or, you have a standalone Adobe program such as InDesign.) 
That’s not to say that you need any of these programs to use this 
book or that if you use QuarkXPress this book won’t help you. It 
is merely that I generally use Adobe InDesign and Microsoft Word 
(in various incarnations) as the non-Apple standards of how fonts 
are handled in Mac OS X; these programs work very well as the 
extremes of the sublime-to-occasionally-ridiculous range. 

• You’ll check current compatibility for any software I 
mention: The tricky part of writing a computer book that men-
tions more than one piece of software is the never-ending update 
problem: a utility that works with Snow Leopard 10.6.0 might not 
work with the 10.6.1 update, and the utility’s update for 10.6.1 might 
break under 10.6.2, and so on. So, if you’re interested in any com-
mercial software or shareware that I mention—Suitcase Fusion, 
PopChar, FontDoctor, WhatEver—please be sure to check that it’s 
been updated to work with your current Mac OS X version. 

WHAT’S NEW IN THIS EDITION 
This book has a 1.0 version number because it has a new title; however, 
it is effectively the third edition in a line of ebooks that includes Take 
Control of Fonts in Mac OS X, Tiger Edition and Take Control of Fonts 
in Leopard. Because the changes from Mac OS X 10.5 Leopard to 10.6 
Snow Leopard are small compared to other improvements in the 
ebook, this book covers fonts in both Leopard and Snow Leopard. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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General changes include: 

• Some condensing of information, and outright deletion of some 
background material (such as the more historical aspects of dif-
ferent font types) to streamline the book. 

• A total reorganization, with the major Organize Your Fonts section 
now located at the end of the book instead of near the beginning. 

• The fonts from Adobe’s Creative Suite 5 are now included in the 
Organize Adobe-Application Fonts topic. 

• The issue of what to do when a software upgrade adds duplicates 
of fonts you’ve organized by moving them elsewhere is covered in 
Upgrading Software after Organizing Your Fonts. 

• A new, streamlined approach to organizing your fonts. Not only 
have I approached the “what to keep/what to toss” assessments 
differently, but instead of your selecting fonts by checking against 
the lists in this book and tediously clicking on the umpteen items 
you need, I’ve provided you with blocks of text to use as search 
terms in the Finder so you can let the Mac find the fonts for you. 
This is such a superior approach over the old one (if I do say so 
myself) that it inspired me to create this combined Leopard-Snow 
Leopard volume so that readers running Leopard could use it 
instead of the process described in the previous edition. I’m also 
advising the use of a two-folder approach to Adobe-application 
fonts to cut down on unnecessary Font menu clutter. 

Additions and changes specifically for Snow Leopard include: 

• Changes regarding which fonts, and what font formats, are included 
with Mac OS X are detailed in Appendix A: Font Tables. 

• New descriptions and figures for the minor change from “Character 
Palette” to “Character Viewer,” and the more significant change 
regarding how to put it, and Keyboard Viewer, in your menu bar. 

• Snow Leopard’s modifications to Font Book. In addition to minor 
cosmetic changes (such as a yellow warning triangle instead of a 
dot to mark duplicate fonts), the search field once again has a drop-
down menu to set a category for your search term, similar to 10.4 
Tiger’s Font Book. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU16998345788&PT=TRK-0106-SAMPLE


10 

Introduction 
  

 
Mac OS X was a major leap forward in the Macintosh interface (and 
its working guts), but a backward step when it came to fonts and their 
management. As a Mac fanatic from way back (1984, to be precise), 
I still hate to admit that it took Mac OS X years to get its act together 
concerning fonts, and that I also totally ignored the issue for as long 
as I could. I know I felt frustrated; I think I also felt insulted. But that’s 
well in the past. 

By Mac OS X 10.4 Tiger, fonts had become manageable but were still 
problematic. Font problems—some predictable, some not so much—
cropped up on a steady basis. The support for new font formats was 
certainly a Good Thing, but it wasn’t necessarily an Uncomplicated 
Thing. With the introduction of 10.5 Leopard, the majority of common 
font problems disappeared, Font Book became a stable utility, and 
users could breathe a sigh of relief in that department. With 10.6 Snow 
Leopard, the transition to twenty-first century fonts and font manage-
ment continues, relatively free of problems. 

You’ll find all the basics of font management in this book: what font 
types are supported, installation, removal, verification of font file 
integrity, and the Font Book how-to (and why). You’ll learn back-
ground details on Unicode and its ripple effect on almost every font-
related thing you do, how to manage an unruly collection of fonts, 
and how to access foreign-language characters and keyboards.  

Due to space constraints and timeliness, I don’t review font manage-
ment software or round up font-related shareware utilities; instead, 
I discuss what to look for in font management beyond Font Book, and 
I highlight a few especially good utilities in context of related topics. 

The main mission of this book is self-evident, but there are two minor 
ones I’d also like to accomplish: to pique your interest regarding char-
acters buried in many common fonts and to help you achieve a certain 
comfort level in dealing with Unicode and glyph IDs for characters. To 
kill both those birds with one stone (and use an awkward metaphor at 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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the same time), where parts of figures need emphasis, I’ve used 
characters from different fonts to point, circle, label, or otherwise 
command your attention. In a special caption, I identify these charac-
ters by font name and Unicode or glyph ID (or both). It looks some-
thing like this picture, though usually more sedate. 

 

 
Jagged arrow: Apple Symbols U+2189 
Dashed arrow: Sand U+2198, GID 350 
Circled letters: MS PGothic starting at U+24D0 GID 17543 

 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Quick Start 
  
The material in this book is presented with the mild assumption 
that you’ll read it linearly, but that doesn’t mean that you have 
to read it that way. You could, instead, start with font installation 
techniques, or inputting special characters. 

 

Begin with the basics: 
• Whether you’re a font minimalist with nary a problem, or a font 

fanatic with nothing but, covering the basics is a good place to start. 
Check out the Supported Font Types, and in Where Mac OS X 
Stores Fonts learn about the oh-so-many places you can store them. 

• Find out about the now-standard approach to modern fonts in 
Explore the Unicode Universe. Discover the wealth of characters 
stored in fonts with The Joy of Character-Rich Fonts, and get up 
to speed with the latest font buzzword (and important concepts) 
in The World According to Glyphs. 

Install and manage fonts with Font Book: 
• If you’d like just a minimum introduction to Font Book, jump to 

Tour the Font Book Window and its following topic, Set Font Book’s 
Preferences. If you’d like more than a passing familiarity with this 
invaluable utility, read the entire Get Acquainted with Font Book 
section. 

• For details on specific Font Book functions, read Validate Fonts, 
Disable (and Enable) Fonts, Create and Edit Collections, and Use 
Libraries to Control Your Fonts. 

• To learn about installing all types of fonts, with and without Font 
Book, see Install New Fonts. To keep track of all the additions to 
your collection, use the tricks in Font-Tracking Techniques. 

• Are duplicate fonts driving you crazy? Deal with Duplicates covers 
both general and Font Book issues in that area. And if you think 
that duplicates are… well, duplicates, jump directly to All Duplicates 
Are Not Created Equal.  

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Work with fonts and type special characters: 
• Font menus are not as straightforward as they seem; iron out the 

wrinkles with Master Font Menus and Font Formatting. 

• As for typing any of the thousands of special characters available 
in some fonts, Control Character Entry describes how to: 

◊ Put Character Viewer and Keyboard Viewer in your menu (Turn 
On the Keyboard and Character Viewers). 

◊ Type basic accented characters (Use Keyboard Viewer to Help 
Enter Accented Letters) and those beyond the very basics (Type 
More Accents with the U.S. Extended Keyboard).  

◊ Enter (and find!) the zillion other characters in modern fonts 
(Find and Enter Characters with Character Viewer). 

• If you want to type entirely in another language, or with a different 
“system,” like the Dvorak method, read Use Different Keyboards for 
Foreign Languages or Other Special Input. 

Organize your fonts: 
• If you have fonts scattered around your drive, learn how to easily 

track them down with Find Misplaced Fonts. 

• Whether your font collection is a mess or merely a nightmare 
waiting to happen, get things in order with Organize Your Fonts, 
and keep them that way with Stay Organized.  

• If you’re struggling with font overlaps between Microsoft Office 
2004 and 2008, see Organize Office 2008 Fonts. That section, and 
Deal with Office 2004 Fonts, address the duplications between the 
respective Office packages and Mac OS X. 

• If you’re drowning in fonts from Adobe Creative Suite programs 
and don’t want all of them, or don’t want all of them in all of your 
Font menus, see Organize Adobe-Application Fonts in Organize the 
Library Fonts Folder.  

• If you’d like to sort out fonts donated by iLife and iWork, read 
Organize the Library Fonts Folder. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Learn Font Basics 
  
We’ve come a long way from the bitmapped fonts on the original 
Macintosh, which were a miracle in the days of the blocky, one-size-
fits-all text on other computers. New font technologies have been 
developed, praised, accepted as a standard, and then nudged aside 
by the next new thing. 

I’ve broken the topic of learning font basics into three parts. You 
need to know them all before you can really wrangle your fonts: 

• Supported font types: The list of different font types that Mac 
OS X supports hasn’t changed since its original release, but the 
types in common usage—and what’s on its way out—has changed. 

• Font locations: Read Where Mac OS X Stores Fonts. Be sure 
to read the entire topic; the last portion, The Font Access Order, 
is especially important. 

• Unicode: You might be tempted to skip my short treatise, 
Explore the Unicode Universe, but I’m warning you: you’ll have 
to come back to it sooner or later! 

SUPPORTED FONT TYPES 
Mac OS X supports a wide variety of fonts. Table 1, on the next page, 
lists the font types in order of their appearance on the computer scene; 
details for each type follow, and Table 2, later, summarizes all the font 
specifications. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Get Acquainted 
with Font Book 
 
Font Book is the Mac’s font-management utility. Its obvious 
raison d’être is to install and remove fonts to save your having 
to run around to all the Fonts folders. But it does more than just 
installation chores: it checks fonts for corruption, indicates and 
resolves duplicates, displays font character sets, copies designated 
fonts into a separate folder to accompany a document to a printer, 
and generally helps you wade through the hundreds of fonts you’ll 
have just by installing a Microsoft or Adobe application or two. 

To do anything beyond blindly installing a font, you need to know 
at least the basics of Font Book—its interface and preferences—
which are covered in this section. Specific Font Book capabilities 
such as its various methods for installing fonts, creating collections 
and libraries, and disabling and enabling fonts are covered in the 
next several sections.  

TOUR THE FONT BOOK WINDOW 
It’s easy to get started in Font Book, because its surface behavior 
and interface are predictable. But that friendly surface belies both 
its versatility and its sometimes quirky behavior and interface 
elements. 

Font Book is in your Applications folder, and it opens automatically 
when you double-click on any installable font file. 

The descriptions here refer to numbered items in Figure 1, on the 
next page: 

1. The Collection list: This list shows built-in and user-defined 
libraries above the line (a) and actual collections below it (b); click 
an item to display its fonts in the Font list. Disabled items (c) are 
dimmed; in Leopard, they’re also labeled with Off. (The Collection 
list is further dissected in Understand the Collection List.) 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Install New Fonts 
 
Mac OS X isn’t overly generous with its font supply, and although 
Microsoft Office adds quite a few and Adobe programs bring a 
truckload, you’ll want to add new fonts yourself at least once in a 
while—or perhaps with alarming frequency.  

This section describes what you should do before you install fonts, 
the various ways you can perform installations, and starts with 
the overwhelmingly important issue of where to find new fonts. 

GET NEW FONTS 
Install what fonts? From where? Some users are drowning in 
unwanted fonts; others just can’t get enough. If you’re in the market, 
you don’t have to spend a cent to add to your font collection. 

Many free-font sites are eyesores, with blinking banners and obnox-
iously intrusive ads; lots of the hits you’ll get on a Google search are 
sites that simply list other font sites (some that list other sites that 
list…). To save you time and wasted effort, I offer a list of my 
favorites—in no particular order—wherein I’ve forgiven an annoying 
ad or two that doesn’t otherwise interfere with the overall interface 
(some of these sites also sell fonts): 

• http://www.dafont.com/ • http://www.eternalfonts.com/ 

• http://www.fontgarden.com/ • http://www.dingbatpages.com/ 

• http://www.highfonts.com/ • http://www.1001fonts.com/ 

• http://www.bancomicsans.com/ • http://www.fontdiner.com/  

• http://www.simplythebest.net/fonts/ 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Validate Fonts 
 
Corrupted font files are an old, familiar problem to experienced 
Macintosh users. The files were corruptible because they were 
“writeable”—the system opened the files not just for use but also 
to change ID numbers in an effort to avoid conflicting IDs. That 
approach, fortunately, fell by the Mac OS X wayside, with font files 
now strictly read-only. Font corruption reported under Mac OS X 
is almost solely of old files. 

Validation is simply Font Book’s way of checking font files for inter-
nal problems. It doesn’t fix the problems; it merely reports them. 

  
Font Book provides three ways of validating fonts: 

• Automatic validation: This is triggered when you install a font 
through Font Book, which is why installing more than a few fonts at 
a time can cause Font Book to seemingly seize up for anywhere from 
30 seconds to several minutes: you’ll see the “in progress” gear spin 
as Font Book churns away at validating each and every font you just 
dragged in from that font CD. 

• File > Validate Font: This command is for already-installed 
fonts; select one or more in the Font list and then use the command. 

• File > Validate File: Choose this to check fonts that are not 
installed yet; you can choose a single font file, or an entire folder 
(which will also include any subfolders in the checkup). 

Why would you need either of the latter Validate commands, when 
Font Book automatically validates fonts on installation? If you install 
fonts by dragging them directly into folders, bypassing the automatic 
validation, you can check them beforehand with Validate File, or 
afterward with Validate Font. Validating in advance saves time, not 
so much for the install-and-then-remove-a-bad-font drill, but because 
once the fonts are installed, it’s time-consuming to pick them out of 
the Font list for validation. In addition, I’ve found that the Validate 
commands sometimes flag a questionable font that passes the auto-
matic validation procedure. 
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Enable Automatic 
Font Activation 
 
Mac OS X’s best Font Book feature could have been the font 
activation introduced in Mac OX 10.5 Leopard: 0pen a document 
formatted with a font not currently in use (whether it’s not installed 
or simply disabled) and the Mac scours your drive and other 
attached volumes for the missing font. It could have been the best 
feature, but it’s not—because it went from somewhat undependable 
in Leopard to almost totally so in 10.6 Snow Leopard. Even Apple’s 
programs (TextEdit, Pages) don’t seem to know how to use it, 
although I occasionally get notifications about missing fonts in 
Word 2004 documents. 

So, this section explains how the feature is supposed to work, not 
necessarily the way it’s actually working—because, what with hope 
springing eternal, perhaps some minor system update will fix it. 

 
Turn on automatic font activation in Font Book’s preferences: 

1. Choose Font Book > Preferences. 

2. Check Automatic Font Activation. 

3. Check Ask Me Before Activating.  

Once you’re used to this feature, if you want it on all the time and 
“invisible,” you can uncheck Ask Me Before Activating. But the option 
lets you know when the feature’s kicking in, and allows you to keep a 
font from being activated, too—handy when it’s some weird font you 
were trying out, forgot you ever used, and then left sitting in a dusty 
corner of your hard drive. 

On but not working: I haven’t found any problems with leaving 
Automatic Font Activation on even though it doesn’t work, but editor 
and fellow Mac author Jeff Carlson had a serious InDesign problem 
as a result. So, remember that these directions assume you have a 
version of Snow Leopard in which this feature actually works! 
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Create and Edit 
Collections 
 
A Font Book collection is a group of installed fonts with something 
in common. You get to define the commonality: it could be as simple 
as Handwriting Fonts, as general as Sans Serif Fonts, or as unique 
as Ivory-billed Woodpecker Weekly Newsletter Fonts. The collec-
tion itself is just a list, an arbitrary subset of already-installed fonts. 

Collections are for convenience in dealing with fonts: 

• When considering just what font to use for a project, you can 
browse through a subset instead of your entire list. 

• You can disable and enable an entire group of fonts at once. 

• You can export the collection instead of individually selecting 
fonts for an export set. 

• In applications that use the Font panel (mostly Apple software), 
a collection serves as a way to winnow the list of fonts you’re 
selecting from, making it easier to get to the one you want. Some 
applications, such as Office 2008’s Word, use collections as the 
basis of submenus in the Font menu. 

 

Let’s say that you often create fliers that need a variety of weights and 
widths in the type, but you never remember which of your fonts have 
condensed faces, which have bolder-than-bold faces, and so on, and 
you’re tired of scrolling and clicking through your entire font collection 
when looking for type ideas.  

Here’s how to make a more limited browsing list for a specific style, 
by creating a collection using Font Book’s Search feature: 

1. Click the plus  button beneath the Collection list or choose File > 
New Collection (Command-N). 

2. Name the new collection Condensed. 

3. Click on All Fonts in the Collection list. 
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Use Libraries to 
Control Your Fonts 
  
Although Mac OS X provides multiple Fonts folders, you don’t have 
to use any of them for fonts you add to your trove: you can store 
your fonts anywhere and make them available for use by creating 
your own libraries in Font Book. 

The distinction between a library and collection is not always clear 
to users, but it’s actually simple: a collection merely lists a subset of 
your installed fonts, while the library is a group of installed fonts. 

LEARN THE LIBRARY ADVANTAGE 
There are many advantages to working with user-defined libraries: 

• The fonts are not installed in any Fonts folder; no copies are made—
the original files, still in their original locations, are accessed for use 
in Font menus and documents. 

• When you remove a font from a library, or a library from Font Book, 
nothing is moved to the Trash—everything stays right where it is. 

• In case of duplicates, the fonts in a library take precedence over 
everything except an application’s Fonts folder, so you can be sure 
(okay, most of the time—there’s always the application’s folder) that 
the fonts you installed as part of a library are the ones being used by 
your programs. 

• You needn’t make a collection, or a multiple selection from the Font 
list, in order to export the fonts you used on a project; if they are all 
in a folder, they’re ready to send to the other user. 

Using font libraries is particularly convenient when you need a group 
of fonts for a short-term or recurring project, such as a monthly news-
letter. You don’t have to clutter your menus with the fonts any longer 
than absolutely necessary, and removing and later reinstalling the 
group is a cinch.  
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Disable 
(and Enable) Fonts 
 
Disabling a font makes it unavailable to applications, without your 
having to remove it from a Fonts folder; you can easily activate it 
again when you want to use it.  

There are three reasons for disabling fonts: 

• To shorten Font menus by turning off fonts you use infrequently. 

• To force the operating system to use a specific version of a 
duplicate font so you can get at its special features or coordinate 
with another computer that will be using your document. 

• On multi-user Macs, to “get rid of” fonts you don’t use without 
actually removing them from a shared Fonts folder, so other 
users can still access them. (Fonts are disabled on a per-user 
basis.) 

DISABLE A FONT FAMILY 
If you have 32 Arno Pro typefaces from Creative Suite in a User Fonts 
subfolder, 32 entries for that font will show up in Font menus and sub-
menus in Microsoft Office applications, and in lists in the Font Panel. 

If you want to temporarily turn off a generous font so that it clutters a 
menu only when you’re using it, here’s what to do: 

1. Quit Microsoft Word if it’s open. Disabling or enabling fonts is 
analogous to removing or installing them, and many applications, 
especially Word, choke if you change the font lineup while they’re 
open. 

2. In Font Book, select All Fonts in the Collection list. 

3. Select Arno Pro in the Font list. 

4. Click  or choose Edit > Disable “Arno Pro” Family. 
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Deal with Duplicates 
 
Theoretically, the existence of duplicate fonts should make no 
difference: the operating system grabs the first one in the access 
order and ignores the rest. And, of course, you may wonder why 
it matters at all: aren’t they, after all… duplicates? 

ALL DUPLICATES 
ARE NOT CREATED EQUAL 
Font Book and Mac OS X define duplicate fonts as those sharing 
a name—which has nothing to do with the filename, but refers to the 
real name stored internally in the font file. This less-than-rigorous 
definition is the crux of many problems. Ostensible duplicates can be:  

• Different types: OpenType, PostScript Type 1, TrueType, dfont—
it may not make any difference to you on your system, but if you’re 
sharing fonts or documents, you may have to match the destina-
tion’s font-handling capability. TrueType and dfonts don’t work on 
pre-OS X Macs; PCs can’t use Mac TrueTypes; a print shop might 
use only PostScript fonts. 

• Different versions: Older font versions may not be Unicode-
compliant; newer font versions may offer more characters. One 
version—not necessarily the newer one—might have more typefaces 
than another. Newer versions may have multiple files where the 
older one had a single file (as with Tiger’s single Verdana file versus 
Leopard’s Verdana, Verdana Bold, Verdana Italic, and Verdana Bold 
Italic); or, newer versions might have a single file when an older one 
had multiple files (as with Leopard’s two Chalkboard files becoming 
a single Chalkboard.ttc file in Snow Leopard). And, once again, 
matching the version of a font on the destination computer could 
be an overriding concern.  

• Different designs: Fonts with the same name but from different 
designers may be noticeably different in some design factors, which 
can change the look of your document. Or the designs might be 
subtly different, especially in the “font metrics” that define the letter 
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Remove Fonts 
with Font Book 
 
You can remove a font directly from its Fonts folder; its absence 
is reflected in Font Book’s list almost immediately. But Font Book 
deletion is a better option because you can see whether you still 
have a copy of that font available in a different Fonts folder, and, 
for fonts with separate typeface files, you won’t have to select all 
the multiple files yourself. (When you’re doing wholesale reorgan-
ization, such as that in Organize Your Fonts, however, working 
directly with folders is the only reasonable approach.) 

 
To remove a font, select it in Font Book’s Font list, and press Delete 
or choose File > Remove FontName. The font file is usually moved 
to the Trash, so if you don’t want it erased the next time you empty 
the Trash, you must drag it out and store it someplace. This isn’t so 
draconian when you consider that a copy of the font file was placed in 
the target folder during installation, with the original left in place. But, 
as I mentioned in the installation section of this book, you should keep 
track of whether or not you’ve stored originals someplace or deleted 
them after they’ve been installed. For fonts that come with Mac OS X, 
you have to be more careful because there’s no easy way to get fresh 
copies (read Restore Missing Fonts). 

The font file is usually moved to the Trash, but there are exceptions: 

• If you don’t have administrative privileges—that is, if you’re sharing 
the Mac and you’re not in charge of it—removing something from 
the Computer library in Font Book removes it from the Font list, but 
the font file remains in its folder.  

The Computer library includes the fonts in both /System/Library/ 
Fonts and /Library/Fonts. Font Book doesn’t let you remove items 
from the former, so removing a font from the Computer library 
means you’re taking it from /Library/Fonts. That folder, however, 
is shared by all users of the computer, so without administrative 
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Print Font Samples 
 
Sometimes nothing beats printed versions of fonts so you can 
peruse your fonts the way most people will see them: on paper. 

  
As a bonus for our patience over the years, waiting for the capability 
to print samples, Font Book provides three different types of samples 
(Figure 21): 

• Catalog: This is meant for, well—a catalog of all your fonts, or 
subsets of them. It prints a sample of letters and numbers for each 
of the fonts you choose; you can set the font size and choose a title 
for each typeface or for each family (choose family!). 

• Repertoire: Be careful with this one, since it prints a grid of every 
glyph in the fonts you choose—and some fonts have thousands! You 
can set the glyph size, and the header includes a glyph count. 

• Waterfall: This traditional font-sample option prints lines of 
alphanumerics in ever-increasing size. You can choose to include 
font details (family name, kind, and so on) for each font. 

 
Figure 21: Font Book’s font sample reports. Left to right: Catalog, 
Repertoire, and Waterfall. 
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Master Font Menus 
and Font Formatting 
  
You’d think locating a font in an alphabetical menu or list would 
be easy. And, in fact, if you’re looking for something simple like 
Arial or Georgia, it is easy. But Font menus differ from one appli-
cation or utility to another, not only in the fonts listed but also in 
the order in which they’re listed. A font may be in an unexpected 
location in a menu or seem to be missing, and formatting text for 
bold or italic may not always work the way you expect it to.  

In this section, I provide the background information you need to 
understand how Font menus work and to solve problems. 

FIND A FONT IN A MENU 
To find some fonts—even a font with a name seemingly as simple as 
Adobe Jenson—you’ll have to get used to how specific applications list 
them, or you’ll waste a lot of time hunting for the font you want. In 
some places, you’ll find fonts listed strictly alphabetically; in others, 
you’ll see fonts with company or foundry names (“Adobe Jenson,” 
“Monotype Corsiva”) listed in a separate group. Non-Roman fonts 
might be listed alphabetically or grouped by language; they may be 
listed in English, totally in foreign (usually Asian) characters, or a 
combination of the two.  

Take, for example, the Adobe Jenson font. In Font Book (and in the 
Font panel, used by most of Apple’s programs in lieu of a Font menu), 
it comes after Zapfino, in a list of fonts grouped by foundry. In 
Character Viewer (see in Find and Enter Characters with Character 
Viewer), it’s at the top of the list, alphabetized under A. Microsoft 
Word also puts it with the fonts that begin with A; InDesign, although 
it refers to the font by its full name, Adobe Jenson, lists it under J. 
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Control Character Entry 
  
Character entry? Isn’t that what we used to call “typing”? Yes, but 
how can you type characters that aren’t printed on your keyboard, 
or aren’t available at all through any key combination? 

You don’t have to learn all the text-entry options in Mac OS X, but 
it’s nice to know they’re there. Start with “Turn On the Keyboard 
and Character Viewers” (below) so you have them at your beck and 
call, and then learn your options or jump to your particular needs: 

• To learn where basic characters such as ™ © √ ≥ ≠ ¢ are, or want 
to type almost entirely in English but need basic accented letters 
so you can meet Chloë at the café for a tête-à-tête mañana, read 
Use Keyboard Viewer to Help Enter Special Characters.  

• When you’re ready to dive into the wealth of characters modern 
fonts provide, start with Learn about Characters in Fonts.  

• If you want to type special ligatures (letters that are typo-
graphically tied together) or editable fractions, Use Smart-Font 
Typography shows you how to do it in amenable programs. 

• To learn how to enter characters that aren’t available from the 
keyboard, read Find and Enter Characters with Character Viewer. 

• If you want to type more than an occasional character from a 
different language you may wish to Use Different Keyboards for 
Foreign Languages or Other Special Input. 

TURN ON THE KEYBOARD AND 
CHARACTER VIEWERS 
Mac OS X provides two text-input tools, Keyboard Viewer and 
Character Viewer, to help handle the problems resulting from three 
issues: not all characters are printed on your keys (where the heck is 
©?); most accented characters need to be generated with a special key 
sequence; and many fonts have characters that can’t be typed with any 
key combination.  
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Find Misplaced Fonts 
 
Spotlight after Mac OS X 10.4 Tiger is incredibly speedy, but that’s 
no reason not to focus your search when you’re looking for fonts on 
your multi-gigabyte drive. In this section, I describe how to find any 
type of font file, and, especially important, how to make Spotlight 
look inside Fonts folders during a search (they’re ignored by 
default!). 

 
A Finder search ignores things inside Library folders. Normally, this is 
a good thing: there are many Library folders, and they hold a gazillion 
little files that programs use and that change quite often. But all your 
Fonts folders are inside Library folders (/System/Library/Fonts, 
/Library/Fonts, and ~/Library/Fonts—even application-specific Fonts 
folders such as /Library/Application Support/Adobe/Fonts)—so they 
won’t be included in a basic search. You might like this if you want 
to search only through your non-installed fonts (through your backups, 
say, or items you’ve downloaded, or fonts you’ve removed to shorten 
your Font menus), but it will drive you crazy when you want your 
Fonts folders included. 

The search technique described in this section can be used for three 
types of searches: looking for all fonts that are outside your Fonts 
folders; looking for specific fonts that are outside your Fonts folders; 
and looking for specific fonts, including those that are inside Fonts 
folders. 

When /Library folders are not an issue: Gather the Adobe 
Fonts describes a search procedure inside the /Library/Fonts folder 
that ignores this issue. The reason that search works, however, is 
because it specifically starts inside that folder, so the Finder under-
stands that you want to use it for the search scope despite its usual 
don’t-look-in-here status. 
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Organize Your Fonts 
 
Are you just beginning your Mac OS X font experience and have 
no idea where to start? Are you drowning in extra fonts that you’ve 
installed in various places and have no idea how get out from under 
the mess you now have on your hands? 

No matter where you fall on the font-muddle spectrum, the guide-
lines and step-by-step procedures here get you on track—and keep 
you there. I’ll show you how to: 

• Get organized: Clean up your current Fonts folders: add 
missing fonts, delete duplicates, and generally sift through what 
might already be an out-of-control font collection. 

• Back up the clean setup: Just in case things go kerflooey 
later. 

• Stay organized: Use subfolders and labels to track old and new 
fonts. 

 
There’s more to organizing your fonts than just dragging them to 
the right locations—although that’s an important part of it. Cleaning 
up your three basic Fonts folders—System, Library, and User—is a 
simple, but multi-step (and I mean multi!), process. Before we get 
started, here’s a general overview of what you’ll do, although some 
of the specifics depend on the folder you’re working in and the 
applications you have: 

1. Restore each folder to the way Mac OS X meant it to be: 
We’ll reinstate missing fonts and offload nonmembers. If you’ve 
removed fonts and don’t want them back, that’s okay—but you 
can get them back if you’ve changed your mind. 

2. Organize fonts that come with applications: Microsoft Office 
2004 and 2008 each provide a large collection of fonts, stored in 
different default locations. If you’ve had both versions, you’ll have 
duplicate fonts, with some of them new and improved; in addition, 
some Office fonts in each version duplicate those supplied by 
Mac OS X. 
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Appendix A: Font Tables 
 
The three topics in this appendix discuss and list the default fonts 
provided by Mac OS X in the System Fonts and Library Fonts 
folders, and those supplied by Microsoft Office 2008 and 2004: 

• The System Fonts Folder (below) 

• The Library Fonts Folder 

• Microsoft Office Fonts 

If you are reading this book in a black-and-white version, you won’t 
see color in font-list tables. If you need to see the color, you can 
access the PDF version of the ebook—see Ebook Extras for details. 

THE SYSTEM FONTS FOLDER 
The fonts in Table 10 (just ahead) are installed by default in the 
System Fonts folder, /System/Library/Fonts. 

But, first the most important information: Do not remove any of the 
following fonts from the System Fonts folder (see The Absolutely 
Necessary Fonts, p. 155, for details): 

• Geneva • Keyboard • LastResort 

• Helvetica • LucidaGrande • Monaco 

• HelveticaNeue 
 

In the table, parenthetical numbers after font names indicate how 
many files belong to the font group: AquaKana (2), for instance, means 
that there are two files (which happen to be AquaKanaRegular.otf and 
AquaKanaBold.otf). 

Font formats: For more information about the font formats listed in 
the last column of the table, see Supported Font Types. 
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Appendix B: 
Users and Accounts 
 
If you’ve ignored the whole user account thing up until now and 
feel practically illiterate when you run into Fonts folder paths, or 
references to using a different account to test your font problems, 
relax: it’s simpler than you think.  

 
Mac OS X is designed as a shared system, serving the needs—and 
preserving the privacy—of more than one user, whether the users are 
various employees or a few family members. If you’re the sole user, you 
have to put up with some nonsense that’s a result of the shared-Mac 
approach, with multiple places to store (and misplace) things, folders 
that seem to have the same names, and the concept of having an 
account on your Mac—an account with an administrator, who, in all 
likelihood, is you. You run into the surface issue of this approach every 
time you install software and you’re asked for an administrative pass-
word (and doesn’t that make you feel important?). 

For most practical purposes, you can think of a Mac as starting with 
a single user account, a setup for a single user. Each user account has 
an owner, the person who has a password to use it. At least one user 
account has administrator privileges; the owner of an account with 
these privileges is allowed to make system-wide changes on the Mac 
that can affect all the accounts on it—like installing applications or 
updating system software. The first user account that’s set up on your 
Mac OS X machine automatically has administrator privileges. So, 
if you’re the only user, you have an account with administrator 
privileges. (You are the boss of you.) 

The multi-user mindset of the operating system results in a hierarchy 
of resources and privileges: 

• System stuff: These are things the Mac needs to keep humming—
everything from starting up to putting a dialog on the screen to 
opening an application when you double-click a document. 
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About This Book 
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. Keep reading in this section to learn 
more about ebook extras, the author, and the publisher. 

EBOOK EXTRAS 
You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB and 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top of 
the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

ABOUT THE AUTHOR 
Sharon Zardetto has been writing about the Mac since 1984 and never 
gets tired of it. It’s going to be quite a while before she tires of her iPad, 
too. She is incredibly tired of waiting for an iPhone that works with a 
cellular carrier other than AT&T. 

Sharon would like to remind you that seatbelts save lives. This book 
was delayed for months as a result of a serious car accident (totally 
not her fault!) that, among other things, left her one-handed for many 
months—which seriously affects typing speed! If not for a seatbelt, 
however, it’s likely her skull would have been as crushed as her wrist. 
This concludes the PSA portion of this book. 
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SHAMELESS PLUG 
Sharon uses far fewer trees for her writing than she did in the first two 
decades of writing, what with ebooks (such as her other Take Control 
titles, Take Control of Safari 4 and Take Control of Safari 5) and the 
online version of Macworld magazine. 

Visit her at http://www.mactipster.wordpress.com/ and 
http://www.ipadpunditry.wordpress.com/; follow her on Twitter: 
sharonzardetto. 

ABOUT THE PUBLISHER 
Publishers Adam and Tonya Engst have been 
creating Apple-related content since they 
started the online newsletter TidBITS, in 
1990. In TidBITS, you can find the latest 
Apple news, plus read reviews, opinions, and 
more (http://www.tidbits.com/). 

Adam and Tonya are known in the Apple world 
as writers, editors, and speakers. They are also 
parents to Tristan, who thinks ebooks about 
clipper ships and castles would be cool. 
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Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!
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Copyright and Fine Print 
 

 

Take Control of Fonts in Snow Leopard 

ISBN: 978-1-61542-088-9 

Copyright © 2010, Sharon Zardetto. All rights reserved. 
 

TidBITS Publishing Inc. 

50 Hickory Road 

Ithaca, NY 14850 USA 

http://www.takecontrolbooks.com/ 
 

Take Control electronic books help readers regain a measure of control in an oftentimes 
out-of-control universe. Take Control ebooks also streamline the publication process so 
that information about quickly changing technical topics can be published while it’s still 
relevant and accurate. 

This electronic book doesn’t use copy protection because copy protection makes life harder 
for everyone. So we ask a favor of our readers. If you want to share your copy of this ebook 
with a friend, please do so as you would a physical book, meaning that if your friend uses it 
regularly, he or she should buy a copy. Your support makes it possible for future Take 
Control ebooks to hit the Internet long before you’d find the same information in a printed 
book. Plus, if you buy the ebook, you’re entitled to any free updates that become available. 

Although the author and TidBITS Publishing Inc. have made a reasonable effort to ensure 
the accuracy of the information herein, they assume no responsibility for errors or 
omissions. The information in this ebook is distributed “As Is,” without warranty of any 
kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person or entity 
for any special, indirect, incidental, or consequential damages, including without 
limitation lost revenues or lost profits, that may result (or that are alleged to result) from 
the use of these materials. In other words, use this information at your own risk. 

Many of the designations used to distinguish products and services are claimed 
as trademarks or service marks. Any trademarks, service marks, product names, or named 
features that appear in this title are assumed to be the property of their respective owners. 
All product names and services are used in an editorial fashion only, with no intention of 
infringement of the trademark. No such use, or the use of any trade name, is meant to 
convey endorsement or other affiliation with this title. 

This title is an independent publication and has not been authorized, sponsored, 
or otherwise approved by Apple Inc. Because of the nature of this title, it uses terms 
that are trademarks or that are the registered trademarks of Apple Inc.; to view a complete 
list of the trademarks and of the registered trademarks of Apple Inc., you can visit 
http://www.apple.com/legal/trademark/appletmlist.html. 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!

http://www.takecontrolbooks.com/
http://www.apple.com/legal/trademark/appletmlist.html
http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU16998345788&PT=TRK-0106-SAMPLE
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Featured Titles 
 
Now that you’ve seen this book, you know that Take Control books 
have an easy-to-read layout, clickable links if you read onscreen, 
and real-world info that puts you in control. Click any book title 
below or visit our Web catalog to add more ebooks to your Take 
Control collection! 

 
Take Control of Apple Mail in Snow Leopard (Joe Kissell): Go under 
the hood with the new (and old) features in Apple Mail 4. Joe gets you 
going and helps you get the most out of Mail. $10 

Take Control of Exploring and Customizing Snow Leopard (Matt 
Neuburg): Learn how to customize your Mac’s interface, navigate 
quickly around your disk, and use special features like a pro. $15 

Take Control of iTunes (Kirk McElhearn): This FAQ-style book 
describes how to wrap iTunes around your little finger and enjoy your 
media more. $10 

Take Control of Mac OS X Backups (Joe Kissell): Set up a rock-solid 
backup strategy so that you can restore quickly and completely, no 
matter what catastrophe arises. $15 

Take Control of Media on Your iPad (Jeff Carlson): Maximize your 
iPad enjoyment by reading an ebook, listening to music, viewing 
photos, watching a video, or using your iPad as a remote control. $10 

Take Control of Safari 5 (Sharon Zardetto): Make the most of Apple's 
Safari, a Mac Web browser with many hidden and under-appreciated 
talents! 

Take Control of Users & Accounts in Snow Leopard (Kirk McElhearn): 
Find straightforward explanations of how to create, manage, and work 
with—and among—user accounts. $10 

Take Control of Your 802.11n AirPort Network (Glenn Fleishman): 
Make your AirPort network fly—get help with buying the best gear, set 
up, security, and more. $15 

Click here to buy the full 225-page “Take Control of Fonts in Snow Leopard” for only $15!

http://www.takecontrolbooks.com/catalog?pt=INTERNAL
http://www.takecontrolbooks.com/snow-leopard-apple-mail?pt=INTERNAL
http://www.takecontrolbooks.com/snow-leopard-customizing?pt=INTERNAL
http://www.takecontrolbooks.com/itunes?pt=INTERNAL
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/ipad-media?pt=INTERNAL
http://www.takecontrolbooks.com/safari-5?pt=INTERNAL
http://www.takecontrolbooks.com/snow-leopard-users?pt=INTERNAL
http://www.takecontrolbooks.com/airport-n?pt=INTERNAL
http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU16998345788&PT=TRK-0106-SAMPLE
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